Installation Instructions - Configuring

1Q5, 1Q5-10

Controller & 1/0 Modules

Important: Retain these instructions

These instructions shall be used by trained service
personnel only. If the equipment is used in a manner not
specified by these instructions, the protection provided by the
equipment may be impaired.

https://[partners.trendcontrols.com
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1 BEFORE STARTING CONFIGURATION

Install the 1Q5, /0 Modules & Adapters

Jeabs

Q500 Installation Instructions - Mounting (TG201482)

1Q528 Installation Instructions - Mounting (TG201513)
IQ5-10 Installation Instructions - Mounting (TG201484)
1Q4/10/.. Installation Instructions - Mounting (TG201342)
XCITE/IOL.. Installation Instructions - Mounting (TG200627)
IQ5-LAN-ADPT Current Loop LAN Adapter Installation
Instructions - Mounting (TG201511)

Prepare the Ethernet Network(s)

Install DHCP Server

If the IP address settings (IP address, subnet mask, default
router, WINS and DNS servers’ addresses) are to be supplied
by a DHCP server, ensure one is installed on the Ethernet
segment to which 1Q5 is connected.

Install IQ®SET on Engineering PC / Laptop

@ <5 > IQSET Manual (TE200147)

Additional Documentation Required

= IQSET Manual (TE200147)

= |P Tool Manual (TE200638)

= IQTool Monitor Applet Manual (TE201298)

= |QTool Addresser Applet Manual (TE201299)
= |Q5 Configuration Manual (TE201486)

Note: PDF copies are included with IQSET installation in the
following folder: C:\..\Trend Control Systems\Documentation

Install DNS Server

If email alarms are to be sent, and the email server address
is identified by internet domain name, a DNS server must be
installed.

Note: 1Q5 does not support WINS. If hostnames are to be
used, then a DNS server is recommended. For security the
use of LLMNR protocol is not advised.

2 CONFIGURATION

Isolate All Power
WARNING Connecting leads may be connected
Isolate all power including additional supplies 1/0 to power supplies. Isolate before touching.
devices and Current Loop LAN Adapters.
o o o o]
| PSU | PSU | PSU PSU |
I\I_II IHRINNRIIRI
e 1Q5 | 1Q5-10 [ 1Q5-10 | 1Q5-10 | 1Q5-10 1Q5-10 || 1Q5-10
IEMIINIININn
o o I o
. PSU e . PSU \ PSU
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2 CONFIGURATION (continued)

@ Open Panel / Enclosure

WARNING Opening the panel may expose
dangerous voltages.

=
g

@ Peel Off Serial Label(s) and Retain (leave front panel protective film in place)
1Q5

1Q5-10 Modules

o - T W Y
\
( e \ P | cdnisED
f | —— N
|| - ( )
e ‘—1 L O — i—1i
-
| T
\_— /—;
R
(g vt \ \ )
Disconnect All I/0 from /O Modules
WARNING Connecting leads may be connected
to power supplies. Isolate before touching.

Leave Q5 Power, Ethernet, RS-485, T1L bus, 1Q3/4 10 bus,

USB and current loop connected (where appropriate).
[T Tl T Tl Tl T Tl T rllllel e
) Y
|~| [ [ias] 1as-10 | 10510 | 1a5-10 | 1a5-10 105-10 | 1Q5-10
|| 5 L
LRSS SULMILL®
Remove terminal covers Unplug connectors Refit terminal covers
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Installation Instructions - Configuring

1Q5, 1Q5-10

2 CONFIGURATION (continued)

@ Set RS-485 Terminator Switches (if RS-485 networks are connected)

-

2
—h

COM - +
RS485 n ISOLATED

Terminator in circuit

2 3 Axn

COM - +
RS485 n ISOLATED

Terminator out of circuit

@ Configure XCITE/IO Modules (where fitted)

XCITE/IO/.. Installation Instructions - Configuring (TG200627)

@ - b Section 2 Only

Q

Connect Engineering PC / Laptop (with IQSET installed)

Note: On IQ500 the Isolated port is disabled by default an cannot be used for the initial addressing configuration.

Either: via Ethernet Hub/Switch

Standard Ethernet cable
(Cat 5e twisted pair)
max 100 m (109 yds)

Or: using direct connection

/1. O

e

x 1Q500 only

Standard Ethernet cable
(Cat 5e twisted pair)
max 100 m (109 yds)

Ethernet Network

1

MOL Y

Hub / Switch

Note: A connection via the USB Local Engineering Port cannot

be used at this point.
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2 CONFIGURATION (continued)

Switch On Power to 1Q5 (including any additional PSUs)

o o
i PSU 1 PSU

|~| [ [ias] 1as-10 | 1as-10 [ 1as-10 | 105-10 105-10 | 105-10
) | ! L

@ Wait for Controller to Boot Up

g 1 \

o oo 0.%

Expected indications

Controller is running OK.
Proceed to step 11.

/ £ One or more modules on the T1L bus or
C)) ( IQ3/4 10 bus is not addressed correctly.
< This can be ignored at this stage -

} proceed to step 11.
§

o \

O

Fault indications

Normal for 30 seconds on power up or
reboot. If displayed for longer than 60
seconds the controller has encountered
a problem and has stopped. Try resetting
the 1Q5 to default settings. (see page
23).

No power - check input power supply

O O
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2 CONFIGURATION (continued)

Configure 1Q5-10 HOA Modules (if required)

] —— IMPORTANT: If Offline mode is selected the 1Q5-10 module
will NOT be configurable for the controller. To change to
Online mode see page 26.
. Note: To reconfigure after initial setup, reset the module by
— following the procedure in section 7 on page 24.
Note: In online mode the language of HOA 10 modules is
set by the controller, any language setting made here will be
Y A overridden by the controller.
4 )
Select Display Language Select Mode
Online mode
A
v Proch ol o ot s offne souup Address module
Demsc,h Go to step 12
DO NOT PRESS
Offline mode
Configuration file not detected
Press dial to start the offline setup
oot fle o deeced Go to section 5
o J
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2 CONFIGURATION (continued)

@ Check Status of T1L Bus (only if T1L devices are connected)
1Q5
- . . Normal operation indication
‘\ """ ‘\ @ Bus is connected and working correctly.
[ Bus is not connected (no T1L devices).
m=e o
Fault indication
o Bus is connected but not working correctly.
Check the bus wiring and that all T1L devices
v i v v are powered ON.
1Q5-10 Modules
R e
Normal operation indication
L R | Bus is active on both sides of the T1L device
(@} o
: O L R | Busis active on | Valid for the last module on
—. @ @ | left side only the bus.
L R | Busis active on -
. . For all others, check wiring
d © | right side only on the side that is unlit.
.
p—q...... Fault indication
L R | Bus is connected on right side but not working
@) @ | correctly. Check the bus wiring and that all T1L
é o ('5 (R) devices are powered ON.
Y ] L R | Bus is connected on left side but not working
= ZT1L () @ | correctly. Check the bus wiring and that all T1L
devices are powered ON.
L R | No valid T1L connection (wiring error or
s @ (] @ | communicate error). Check the bus wiring.
1Q5-LAN-ADPT L R | Bus is not connected (no T1L devices) on
([ @ | either side.
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2 CONFIGURATION (continued)

@ Check Ethernet Indicators (for any connected ports)

Normal operation indication

%ﬁl—% 1000 Mbps link detected
H_HT% 100 Mbps link detected
F_HT% 10 Mbps link detected

Note: The indicator will flash when data is being transmitted
or received.

Q500 only

Connect to 1Q5 using IP Tool
Note: On IQ500 the Isolated port is disabled by default an cannot be used for the initial addressing configuration.

Using the PC/laptop (see step 7) run IQSET / IP Tool

B4
IQSET Manual (TE200147)
v fgmd ome | e | e <:j b-
ey T TE— @ IP Tool Manual (TE200638)
- TarkTT 3y
S s e
e : = = =
L. e sl Tl ) L=
‘: oy |

Then find the I1Q5 by its MAC address, as shown on the
serial label

(EI-,[M&L N O B )
T
OF
| L E,

BN TMSHSFIREITIEH

1Q5, 1Q5-10 Controller & 1/0O Modules Installation Instructions - Configuring TG201483 Issue 5, 12-May-2025 7



1Q5, 1Q5-10

Installation Instructions - Configuring

2

CONFIGURATION (continued)

Set up Addressing Details (1Q5 Mode)

This step describes how to set up the addressing details when the 1Q5 is to operate in IQ5 mode. For details of
setting up the addressing details for Compatibility Mode see step 16.

Note: On IQ500 the Isolated port is disabled by default an cannot be used for the initial addressing configuration. Once the initial
addressing information has been set up the required Ethernet ports can be enable/disabled and configured as required in the

controller’s strategy.

With the IQ5 selected in the IPTool devices list, check the following parameters and set as required.

IMPORTANT: The Network Key, lan and node parameters MUST be set.

Parameter Setting / Value Further Details

*IQ4 Compatibility = operate in Q5 mode For the 1Q5 to operate in IQ5 mode this check box must
Mode be unchecked

Network Mode = = build Trend network with other devices | In standalone mode the 1Q5 will not build a LAN or
- Networked* (default) internetwork with other devices.

= operate in standalone mode

Network Mode
- Auto-ip-DHCP*

= = dynamic IP DHCP (default)
= static IP addressing

If set to DHCP mode but no DHCP server is found, the
1Q5 will operate in link/local mode where it auto negotiates
its IP address with other devices on its Ethernet segment.

Note: It is recommended that link/local only be used on a
single segment system.

IP Address*,
Subnet Mask*,
Default Router*

If static IP addressing is selected enter the
required values in the format:
XXX XXX XXX XXX

WINS is not supported by 1Q5. If hostnames are to be
used, then a DNS server is recommended. The use of
LLMNR protocol is not advised.

Hostname Default is ‘Trend-’ plus the last three octets | The hostname may comprise upper or lowercase
from the MAC address. Change if required. | characters A to Z, digits 0 to 9, underscore or hyphen, with

no spaces.
UDP Default is 57612. If required, this can be | All IQ5 controllers that are required to be part of the

changed to a value in the range 0 and 65535
(recommended range 49152 to 65535).

Network Key Enter a suitable key comprising at least

10 alphanumeric characters (no spaces).

Do not forget the Network Key!

same Trend network must have the same udp port
number and the same network key. Multiple Trend
networks can exist on the same physical network, in which
case each separate Trend network will require a different
network key.

HINT: For consistency, type the network key into a text
editor (e.g. Notepad), then copy and paste it for each
device.

Note: If the network is on the same Ethernet network as a
legacy Trend network the two networks MUST NOT share
the same UPD port.

virtual CNCs* Click Auto Number vCNCs or double-click
on aVvCNC in the virtual CNCs list and enter

the following:

node - the vVCNC address 1,4 t0 9, 11 to 119
(0 = vCNC disabled)

port - the vCNC port number 1 to 32767

Note: If Use Default Port is checked the port

number will be set to 10000 plus the node

address (e.g. node 23 = port 10023).

The 1Q5 has four vCNCs (or eight when licenced as an NC
device). All vVCNCs are all disabled by default. At least one
VCNC must be enabled to allow a supervisor, tool or local
display to make a connection to the Trend system.

For most systems it is recommended to have vCNCs
on at least two separate devices on each LAN in order
to provide continuity of communications (if one device is
offline) and to provide load sharing during intensive data
transfer operations (e.g. when downloading plot data).

LAN* Enter the required local LAN number:

1,4t09, 11to 119

Note: This must be the same for all devices
required to form a LAN.

os* Enter the required device address:

1,4t09, 11to 119

Note: This must be unique on a LAN.

IQ5 controllers are given a default device address of 20
and LAN number of 20 in the factory.

Identifier Enter a name that identifies the controller

within the system.

To avoid potential confusion, it is generally recommended
that this is made the same as the hostname.

Click the WRITE DATA button to save the new settings.

*Indicates the 1Q5 will reboot when the parameter is saved.
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1Q5, 1Q5-10

2

CONFIGURATION (continued)

@ Set up Addressing Details (Compatibility Mode)

This step describes how to set up the addressing details when the 1Q5 is to operate in Compatibility Mode. For
details of setting up the addressing details for IQ5 Mode see step 15.

On 1Q500s the isolated port is not supported in compatibility mode. Once the initial addressing information has been set up the
required Ethernet ports can be enable/disabled and configured as required in the controller’s strategy. With the 1Q5 selected in
the IPTool devices list, check the following parameters and set as required.

IMPORTANT: The lan and node parameters MUST be set.

Parameter Setting / Value

Further Details

*1Q4 Compatibility | = = operate in Compatibility mode
Mode*

For the 1Q5 to operate in Compatibility mode this check
box must be unchecked =.

Network Mode “ = build Trend network with other devices
- Networked* (default)

= operate in standalone mode

In standalone mode the 1Q5 will not build a LAN or
internetwork with other devices.

Network Mode = = dynamic IP DHCP (default)

If set to DHCP mode but no DHCP server is found, the

*
Default Router XXX XXX XXX XXX

- Auto-ip-DHCP* = static IP addressing 1Q5 will operate in link/local mode where it auto negotiates
its IP address with other devices on its Ethernet segment.
Note: It is recommended that link/local only be used on a
single segment system.

IP Address®, If static IP addressing is selected enter the

Subnet Mask*, required values in the format:

Hostname Default is ‘Trend-’ plus the last three octets
from the MAC address. Change if required.

The hostname may comprise upper or lowercase
characters A to Z, digits 0 to 9, underscore or hyphen, with
no spaces.

UDP Default is 57612. If required, this can be
changed to a value in the range 0 and 65535
(recommended range 49152 to 65535).

All 1Q5 controllers that are required to be part of the
same Trend network must have the same udp port
number. Multiple Trend networks can exist on the same
physical network, in which case each separate Trend
network will require a different udp port.

Remote Devices Enter up to 20 remote Trend devices by
clicking | *! and entering the following for
each device:

IP Address and Subnet Mask in the
format:
XXX XXX XXX XXX

Note: If Use Hostname is checked the
device can be specified by entering its
hostname instead of IP Address. If using
DHCP it is advisable to use hostnames.

If a Trend LAN is to be built across a router(s) details of
devices on each subnet must be specified to enable cross-
router communications. It is recommended that at least
two devices from each subnet are specified. For increased
reliability details of up to 20 devices should be specified.

If static IP addressing is being used the list should contain
the devices with the lowest IP addresses.

The same list must be copied to other IQ5s on the network.
HINT: Ticking the check box next to the Remote Trend
Devices list retains the list in IPTool, allowing it to be easily
copied to other devices.

virtual CNCs* Click Auto Number vCNCs or double-click
on a vCNC in the virtual CNCs list and enter
the following:

node - the vCNC address 1,4 t0 9, 11 to 119
(0 = vCNC disabled)
port - the vCNC port number 1 to 32767

Note: If Use Default Port is checked the port
number will be set to 10000 plus the node
address (e.g. node 23 = port 10023).

The 1Q5 has four vCNCs (or eight when licenced as an NC
device). All vCNCs are all disabled by default. At least one
VCNC must be enabled to allow a supervisor, tool or local
display to make a connection to the Trend system.

For most systems it is recommended to have vCNCs
on at least two separate devices on each LAN in order
to provide continuity of communications (if one device is
offline) and to provide load sharing during intensive data
transfer operations (e.g. when downloading plot data).

LAN* Enter the required local LAN number:
1,41t09, 11 to 119

Note: This must be the same for all devices
required to form a LAN.

os* Enter the required device address:
1,4t09, 11 to 119

Note: This must be unique on a LAN.

IQ5 controllers are given a default device address of 20
and LAN number of 20 in the factory.

Identifier Enter a name that identifies the controller
within the system.

To avoid potential confusion, it is generally recommended

that this is made the same as the hostname.

Click the WRITE DATA button to save the new settings.

*Indicates the 1Q5 will reboot when the parameter is saved. If an IQ5-LAN-ADPT is connected the IQ5’s the Type 1 (IQ LAN)
Network module will be enabled when the I1Q5 is put into compatibility mode.

-]
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2 CONFIGURATION (continued)

@ Record the Address Details of the Controller

Device address (O/S)
= LAN number
» Fixed IP Address or Hostname (if DCHP)

STOP!
It is recommended that you complete step 15 or 16, & step 17 for all IQ5
controllers in the Trend network before proceeding.

Check LAN OK Indicator (not NC Mode or connected to current loop)
Normal operation indication

A I \ O} LAN built OK with at least one other device.
\ \ ¢ e Attempting to build a LAN with other
L% devices. This may take several minutes.
=END .. . P Contrqller set to .standalone mode and will
not build a LAN with other devices.

} Fault indication
¢

If this continues to show for more than a few
O\,. minutes this indicates that the controller has
not found any other devices on the same
LAN. Use IPTool to check device settings.

Connect to the Trend Network using IQSET
Using the Engineering PC/Laptop (see step 7)
run IQSET and make a connection to the Trend <:| IQSET Manual (TE200147)

Network (or Site). For example:

Open a new site (e.g. File > Open/New Project > Live = Click OK twice.

Site). = In the System View panel, double-click the site name in
* Inthe IQSET System View panel right-click on Sites and the Sites tree:
select New Site.
= Select Trend as the network type and click OK. — o
= Enter a Site name and click Edit site details. The PP ppnapiey < sl 4 b 0 . L
Connection Wizard will appear. —
Select Launching TUA Editor and click Next. The TUA 5 ; £) .ﬁ;
editor will appear. Select the CNC tab: -
[ B
LT - . O e
W i i
sl i i 1Q5 Mode
T iy — If the 1Q5 (to which you are connecting) already has a System

Account set up, then you will now be asked to login using the
appropriate credentials - go to step 22 on page 12.

a2 | e Otherwise, you will be prompted to press the controller’s
) service button to validate the connection and create system
accounts - go to step 20.
= Select TCP/IP, enter the IP Address (or hostname) of an
IQ5 and add at least one valid vCNC port in the Remote Compatibility Mode
IP port list. You will be prompted to press the controller’s service button to
validate the connection and create a CNC user - go to step 21.
Note: If using a hostname and DNS or LLMNR is not
supported on the network, add “local’ to the hostname
and ensure that IQSET is connected to the same segment.
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1Q5, 1Q5-10

2 CONFIGURATION (continued)

20

If you attempt connection to an IQ5 that has no
system accounts setup, then IQSET will display:

T 1 e Skt Fulidaiime b s 55

el ¥ e Thed BTN ] Tl LN G R
o LR BEIERE B AFF M ! L mli Bl
g D [Pl A & prind Lisih] BeFaR e GRS i
R L RE R o T P P s

i B B i Try i | 1

«  Press the service button # on the controller within the
specified time limit:

/O The LAN OK

indicator will be
1.|.I flashing fast on the
required controller

O
e f’%
\- J

= IQSET will now display a dialogue box for you to enter an
Account Name, Password and Email address for the
Admin system account.

~

Note: The email address is required in order to recover
from a forgotten password.

= Click = _to create the account.
=  You will then be given the option to create a single
Engineer system account - click Yes or No as required.

Validate the Connection to IQ5 and Create System Accounts (IQ5 Mode Only)

The new system account(s) will now be set up on the controller
and synchronised with all other 1Q5 controllers on the same
Trend network, i.e. any 1Q5 controller that has:

= the same Network Key and UDP Port set up, and
= no pre-existing system accounts.

This will take a few seconds to complete, after which time
IQSET will display a login box - go to step 22 on page 12.

Note: To add further system accounts go to the System View
in IQSET, right-click the site, select System Account Manager
and follow the instructions in the IQSET Manual.

@ < §> IQSET Manual (TE200147)

Remember to provide the credentials of the Admin
system account plus the Network Key to the site owner
to enable them to manage the system accounts. If the site
owner does not have access to IQSET you may need to add
another Admin system account for each system integrator
working on the site.

If you attempt connection to an IQ5 that has no
CNC user setup, then IQSET will display:

T 1 S Skt Fulibiime b T B

Pl F T el Thees B N ] Tl LN G RS
L E e T PR LR S LR | T
Fuak s | Ui AR = risd L] ReF AR The RFEE i

L R T ok e e

e T A e N L L

«  Press the service button & on the controller within the
specified time limit:

The LAN OK )

indicator will be
flashing fast on the
required controller

O
e /‘%
\- J

Validate the Connection to IQ5 and Create CNC User (Compatibility Mode Only)

= IQSET will now display a dialogue box that enables the
1Q5’s vCNC connections to be configured.

= Enter the CNC User module’s name in the Name box.

= Enter the CNC User module’s password in the Password
box.

= Retype the password in the Retype Password box.

= Click Commit.

The CNC User module will now be set up on the controller
This will take a few seconds to complete, after which time
IQSET will display a login box - go to step 22 on page 12.

1Q5, I1Q5-10 Controller & 1/0 Modules Installation Instructions - Configuring TG201483 Issue 5, 12-May-2025
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1Q5, 1Q5-10

Installation Instructions - Configuring

2 CONFIGURATION (continued)

@ Login to the Trend Network

If you attempt connection to an IQ5 that has system
accounts (IQ5 mode) or CNC Users (compatibility
mode) setup, then IQSET will display:

=
ﬁ I'rrher credmabinl e dzr aibe: Techpahe RIn (TON}
' rrher meer credea bl = s crder o naln sooeas o Hile
=it

Ua e [

Hipaen | nzin

= Enter the User Name and Password for a valid Admin or
Engineer system account.
Click OK.

= In the System View panel click the site name to refresh
the site details (or right-click and select Refresh).

Create Strategy in IQSET

@)

= InIQSET click File > Open / New Project.

= Select Create New SET Project and click OK.

= Enter the required details and click OK.

= Inthe Project View panel add the required LANs by right-
clicking the project name and selecting Insert Lan.

= Enter the required LAN Number and Label, and click OK.

Create an IQSET project and create a strategy
for each 1Q5 controller.

Note: The LAN number should match the LAN(s) defined
using IPTool in step 15.

= Add the required 1Q5 controllers by right-clicking a
LAN and selecting Insert Device > IQ Controller. The
Controller Selection dialogue appears:

L T LR e 7 &
Rasze Daradka
g s e freres -
Lo vt ) -
i I Toedd I -
ires Uyran
[T I T ke Uaravka
LN ekl
e oapudebiy vaie =i icdeal
INT-ATE™ INeme 50
e, NN B T T
[FL1 B
TR
e s ol DR o Bl I L oy ' —
-

= Select 1Q5 and select the required number of 1/0 points
(I/0 Total) and features (Options) and click OK.

Note: For Compatibility mode select the Compatibility
Mode check box, for IQ5 mode leave it un-selected.

<::] IQSET Manual (TE200147)
1Q5 Configuration Manual (TE201486)

= In the Device Details dialogue enter the controller
Address and Name, and click OK.

Note: The Address should match the node(s) defined
using IPTool in step 15.

= In the Address Module dialogue enter any required
settings and click OK.

= In the Sensor Type dialogue enter any required settings
and click Exit.

Set up 10 Modules (if installed)

= Right-click in the empty strategy page and select Device
> 1/O Setup.

= In the 1/0 Setup dialogue add and configure any 10
Modules as required by following the instructions in the
IQSET Manual.

Configure Remaining Strategy (as required)

= Create the remainder of the strategy by following the
instructions in the IQSET Manual and 1Q5 Configuration
Manual.

Local User Modules

1Q5 Mode: It is not necessary to create local User Modules
for the 1Q5 when it is operating in IQ5 Mode, unless these are
required to control end users access to the web interface or
the IQVIEW SCD (single controller display). All engineering
access is controlled by the system accounts created in step
19.

1Q5 Compatibility Mode: Local User Modules control all
access to the IQ5 and MUST be created.

12 1Q5, 1Q5-10 Controller & 1/0 Modules Installation Instructions - Configuring TG201483 Issue 5, 12-May-2025.



Installation Instructions - Configuring

1Q5, 1Q5-10

2 CONFIGURATION (continued)

Set up 1Q5 Feature Licencing

= Ensure that an 1Q5 with the same address and LAN
number with the required options exists in the SET project
see step 23.

= With IQSET connected (see step 19) and logged in (see
step 22), go to System View.

= Right-click the site name in the Sites tree and select 1Q5
Feature Licensor.

= Select the device(s) required and click ' to generate a
Licence Request File and save it on the PC.

* Login to the HBT Licensing Portal:

If any licensable features are required (e.g.
additional 10 points, NC or INT functionality)
these must now be enabled.

https://MyBuildings.honeywell.com
= Select Quick Cart and upload the License Request File.

= Add any additional details including the email address of
the person requiring the licence, then checkout the order.

<::| See ‘Licence |Q5 Features’ in the
IQSET Manual (TE200147)

After the order has been processed an email will be sent to
the specified email address. You will then need to...

= Download the Licence File from the Portal and save it.

«  Using the IQ5 Feature Licensor click £ to import the
Licence File.

= Select which device(s) to update.

= Click  to update the device licences.

Note: If you are not connected to the same IQ5 vCNC that was
used when creating the Licence Request File a warning will
be displayed. If you are connected to the same site you can
ignore the warning. If you are not connected to the same site
connect using a different connection.

)

= Using the Engineering PC/Laptop (see step 7) open a
compatible web browser and access the IQ5 web interface
using its IP Address or Hostname.

= If prompted, login using valid system account credentials.

= Select Modules > Networks to display the NC
Configuration Wizard.

e "N |

Note: The IQ5 must be licenced for NC mode.

Loran

= Click required mode icon (see table), and if necessary
specify any parameters, e.g. LAN number.

Note: If no icons appear, check that the Q5 is configured
and licensed for NC operation (see step 23 & 24).

= Click \I"'r; the controller will now reboot.
= Set the communications channel on the MS/TP network
module to the port the MS/TP network is connected to.

Set up NC Communication Mode (if the IQ5 is required to operate as node controller)

Mode Parameter Settings
Icon
g Ethernet Internetwork to to MS/TP LAN (default)
= Parameter Setting
- BACNet MSTP |[1,4t09, 11to 119
LAN number
BACnet IP No = Enabled
Disable Module |Yes = Disabled
. Current Loop Internetwork to MS/TP Lan
o = ||Parameter Notes
s Lan number 1,41t09, 11 to 119
BACnet IP Can be disabled
| - Ethernet Internetwork to Current Loop Lan
— Parameter Notes
ol 4 Lan number 1,4t09, 11 to 119
BACnet IP Can be disabled
BACnet MSTP Can be enabled
B Ethernet Internetwork to  Current loop
—— Internetwork Note address no longer needs to

== be >100.

daaa
Parameter Notes
Lan number 1,4t09, 11 to 119
BACnet IP Can be disabled
BACnet MSTP Can be enabled
Manual configuration of all parameters
- (not recommended)
1
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Installation Instructions - Configuring

2 CONFIGURATION (continued)

The 1Q5s web server enables users to access the web
interface for viewing/changing module parameters (including
setting up NC mode - see step 25) or interacting with optional
GraphlQ pages via a web browser.

Connection to the IQ5’s web server can be made via HTTP
and/or HTTPS protocol and both these ports are enabled by
default.

Note: Where HTTPS is used it will be necessary to configure
SSL certificates (see the IQ5 Configuration Manual).

If access to the web interface is not required itis recommended
that both ports are disabled for security. For example:

= Using the Engineering PC/Laptop (see step 7) open
a compatible web browser and access the 1Q5 web
interface using its IP Address or Hostname.
If prompted, login using valid system account credentials.
= Select Modules > Networks.
Select n1 (Ethernet IP).
= Set the Web Server Port Number and/or Secure Web
Server Port Number parameters to 0 to disable the port.
«  Click «.

@ Configure or Disable the Web Server (if required)

<::| 1Q5 Configuration Manual (TE201486)
IQSET Manual (TE200147)

Set up Current Loop Baud Rate

If the 1Q5 is to connect to a Trend current loop network
baud rate for the current loop network must be specified.
The 1Q5 will automatically detect the baud rate being used
on the network and set itself accordingly. On systems where
there is only IQ5s and 1Q4s on the current loop network, the
controllers will decide amongst themselves what baud rate to
use; this may not be the one that is required. In this situation
it is necessary for one controller to be set to a specific baud
rate using IQSET’s IQTool Monitor Applet to ensure the other
controllers select the required baud rate.

@ <::| b IQTool Monitor Applet Manual (TE201298)

Download Strategy to 1Q5 Controller

28

For a single controller...

= Select the appropriate controller/strategy in the Project
View.

= From the Strategy menu select Create Data File.
In the System View select the appropriate controller.

= Right-click the controller and select Send File to Device.
In the File Download dialogue box check that the correct
file is selected the in Transfer Directory field.
Click (=] to start the download.

Use IQSET to download the strategy to the
controller(s).

For other methods or for downloading to multiple controllers
please refer to the IQSET Manual

@ - §> IQSET Manual (TE200147)

IMPORTANT: The controller’s date and time MUST be set
correctly to ensure that the controller’s security certificates
can be correctly validated. Communications issues will occur
if the security certificates are not valid. This can be done by
selecting the option to set the controller’s time is selected
when downloading the strategy.

Note: If the strategy uses an NTP server to set the IQ5’s time
and date, synchronisation will only occur if the 1Q5’s time and
the server’s time are within 49 days of each other.

Note: The controller’s date and time may be set up from a
controller configured as timemaster.

|
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2 CONFIGURATION (continued)

Check RS-485 Network Indicators (if RS-485 devices are connected)

Normal operation indication

© | Port configured OK and communications are good.

P Port not active. No Network module exists in the
controller strategy or is not configured correctly.

} Fault indication

/ / 1Q500 only No communications or no network connected. Does
' ' @ |not apply when port is assigned to a network XNC
serial module.

Note: A controller configured for NC operation will show @ on
port 1 until BACnet devices are connected.

Check Ethernet Indicators (for any connected ports)

Normal operation indication
F_H 1000 Mbps link detected
o
F_HT% 100 Mbps link detected
F_HT% 10 Mbps link detected
Note: The indicator will flash when data is being transmitted
i or received.
T
/ \ 1Q500 only
1Q500 only

1Q5, 1Q5-10 Controller & 1/0O Modules Installation Instructions - Configuring TG201483 Issue 5, 12-May-2025 15



1Q5, 1Q5-10 Installation Instructions - Configuring

2 CONFIGURATION (continued)

1Q5-10 Modules

@ Check Status Indicator of T1L Devices (if connected)

""" o Normal operation indication
T1L device operational and
address set OK.
If all T1L devices are in this state,
go to step ‘32’ on page 18.

oo T1L device is booting up - please
wait a few minutes and check
again.

""" o 1Q5-10 HOA module is in Offline

mode

Address is being set after
Service button has been
pressed.

P Every 0.5s
- _ Download or  configuration
— C)) ( in progress. - configuration
— address via software.
Every 0.2s
""" ()
Fault indication
1Q5-LAN-ADPT Factory default mode T1L device

s
i)

not addressed properly - go to
step ‘31" on page 17.

O

T1L device not powered - check
connection from previous
module or separate PSU (if
applicable)

O

The T1L device has encountered
a problem.

O

After T1L device has booted up.
Communication with controller
lost or for IO modules there is an
issue with an input channel.

16
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1Q5, 1Q5-10

2 CONFIGURATION (continued)

Set the Address of an I/0 Module or Current Loop LAN Adapter

The 1Q5 controller will automatically attempt to match each physical device (I/0O module or Current Loop LAN
Adapter) with its corresponding strategy 1/0 module and set its address accordingly.

However, the controller will be unable to set the address if:

= there is more than one unaddressed physical device of
the same type,

= there is more than one unaddressed strategy module of
the same type, or

= there is no corresponding strategy module in the strategy.

Should any of the above situations arise it will be necessary

to set the address of any affected device using either of the
following methods.

Method 1: Use the 1Q Tool Soft Addresser Applet in IQSET.
IQ Tool Soft Addresser Applet Manual
<:j (TE201356)

= Use the applet to assign the physical device to the
appropriate strategy 1/0 module.

Method 2: Use the controller web interface.
@ - §> 1Q5 User Guide (TE201490)

= Login to the controller’s web interface.
= Access the 1/0 Module page and enter addresses as
required.

Identifying a Module using the ‘Wink’ Function (if required)

To help identify a specific module it can be placed in ‘wink’ mode, either from the module itself or set up tool. While in wink mode
the module’s service indicator #l& will flash and the status indicator ring of the corresponding controller will also flash green.

Method 1: Use the module’s service button..

= Press the module’s service button # briefly (<1 second).

»  The module’s service indicator #l& will flash for
approximately 1 minute, showing that the device is in wink
mode.

= Open either the 1Q Tool Soft Addresser Applet or the
controller’s web interface (see Method 2 and 3).

= Any module in wink mode will have its Wink parameter
setto ‘On’.

Note: If a T1L device is not visible in either the applet or the
web interface, it may be because it has already be used with
another controller. A T1L device becomes bound to the first
controller it connects to over the T1L bus. If connecting the
module to a different controller it will need to be reset as
shown in section 7 on page 24.

Method 2: Use the IQ Tool Soft Addresser Applet in IQSET.

1Q Tool Soft Addresser Applet Manual
<:j (TE201356)

= Click the button for the appropriate module.

= The button background will flash green and the module’s
service indicator #*|& will flash, showing that the device
is in wink mode.

= Click the button again to turn off wink mode.

Method 3: Use the controller web interface.

< b IQ5 User Guide (TE201490)

= Login to the controller’s web interface.

= Access the /0 Module page.

= In the Wink column set the parameter to ‘On’ for the
appropriate module.

»  The module’s service indicator /| will flash, showing
that the device is in wink mode. It will continue to flash until
the corresponding Wink parameter is set back to ‘Off’.
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2 CONFIGURATION (continued)

@ Check Tx and RX Indicators (IQ5-LAN-ADPT only)

Normal operation indication
1Q5-LAN-ADPT ®
T Current loop is intact on the Tx side.
= = X
g Current loop is intact on the Rx side.
X
O/ Fault indication
[ J Signal not reaching RX on
Tx downstream device on network
= = [ ] No TX signal from upstream
Rx device on network.
= Check connection between IQ5-LAN-ADPT and IQ5
= Check baud settings of all devices on current loop
= Check all device connections.

Switch Off Controller (including additional PSUs)

< PSU PSU
) ) H
~| [ [ias] ias-0 | ias-i0 | 1as-i0 | 1as-10 | 1a5-10 | 1as-10
| u s

PSU

@ Reconnect Inputs
| |
TTTT Tl TTTal TTTalTTTalTT e sllllelllle

VY i ul
[~ | /|Q5||Qs-|o 1a5-10 || 1a5-10 | 1a5-10 1a5-10 || 1a5-10
l ] L]

P -

CAUTION: Check that each input connection is appropriate for the |0 module input type. For example, ensure that a
mains voltage is not applied to a low voltage input.

|
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2 CONFIGURATION (continued)

Switch On Controller & Input Supplies (including additional PSUs)

PSU

]/ /lQS 1050 [ 1a5-10 [ 1a5-10 | 10510 105-0 [ 10510

@ Check Input Operation
Analogue Digital
ﬁ?

¢_

B
-froji = © ——-
] ®

b
\
/

)

1Q4/10 Modules

@ <:j b 1Q4/10/.. Installation Instructions - Configuring (TG201161)

Section 4 Only

XCITE/IO Modules

@ <:: b XCITE/IO/.. Installation Instructions - Configuring (TG200627)

Section 4 Only

Switch Off Controller & Input Supplies (including additional PSUs)

PSU PSU
|||\|_|\| 1R L
~| [ fias] 1as-10 | 1as-10 | 1as-i0 | 1as-10 | 1a5-10 | 1a5-10
| u u
PSU p——
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2 CONFIGURATION (continued)

Reconnect Outputs
= =

V)
[~ | /|Q5 105-0 [ 1a5-10 | 1as-10 | 1as-10 | 1a5-10 | 105-10
]

p -

IMMETENRIRNT 'Uﬂﬂllu'

CAUTION: Check that each output connection is appropriate for the IO module output type. For example, ensure that a
mains voltage is not applied to a low voltage output.

Switch On Controller, Input & Output Supplies (including additional PSUs)

| — I - —

|||\||| NIRRT L

[~ | ’[ I/le 1510 [ 1a5-10 | 1as-10 | 1as-10 l l 105-0 | 1a5-10
O T T T T ]

Check Output Operation
Analogue Digital

Channel Indicator

Channel Indicato

1Q4/10 Modules XCITE/IO Modules

1Q4/101.. Installation Instructions XCITE/IOL.. Installation Instructions
<:| b - Configuring (TG201161) <:| b - Configuring (TG200627)

Section 4 Only Section 4 Only

Backup Strategy

It is good practice to upload the strategy from each controller
into IQSET to create a backup. <j b IQSET Manual (TE200147)

If required, you can also compare this uploaded strategy with
that held in your project and check for any differences.
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2 CONFIGURATION (continued)

Install Supervisors or Displays (if required)
If a supervisor or local display is required, install these now following the appropriate

@ <,‘ZI b installation instructions and the guidance notes below. Otherwise go to step 43 on page 22.

Connection Method Suitable for
IP Tool IQSET Supervisor Web Interface
(e.g. IQVISION) (e.g. IQVIEW SCD for 1Q5)
Direct via Ethernet Port 4 v'* v v
Via Ethernet Network 4 v* v v
Direct via USB Engineering Port x v x x
* connection requires a vVCNC to be configured on the target controller.
Direct Connection via Ethernet Port Connection via Ethernet Network

[b \

IQVIEW

; IQVIEW
SCD SCD
. —— | ~ |

d -t ———— "* \ (N S—
1Q500 only A ——— IQ500 only S
RJ45 Standard Ethernet cabl Standard Ethernet cable
(Cat 5 twisted pair) 10500 only (Cat 5 twisted pair)
max 100 m (109 yds) max 100 m (109 yds)
2/
= To make a connection with IQSET or supervisor ensure Dﬂ
that a vCNC is available in a Trend device on the same
Ethernet Trend network and connect to the vVCNC as ] Router IEI IEI IEI IE
described in the supplied documentation. Hub / Switch

Note: If connecting with IP Tool, the PC should be on the
same Ethernet segment as the 1Q5.

= To make a connection with a web browser run the web
browser on the PC and access the 1Q5’s IP address or
host name.

= To make a connection with an IQVIEW SCD, install the
IQVIEW SCD application on the controller, then configure
the display device with the URL of the IQ5 controller. For
full details see IQVIEW Single Controller Display for 1Q5
Manual (TE201504).

Direct Connection via USB Engineering Port

q This method is only suitable for a temporary connection with
IQSET during system commissioning or fault finding.
PC
(with
IQSET)
%
o
. ]

connector
(behind flap)

USB cable
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2 CONFIGURATION (continued)

Close Panel / Enclosure
The configuration procedure is now complete!

|
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3 RESETIQ5 CONTROLLER TO FACTORY DEFAULTS

A factory reset will erase the strategy and reboot the controller into its default configuration.

Isolate Power and Disconnect All /O

O,

Follow steps 1, 2, 4, 8 and 9 (on pages 1 to 4) to:

= Isolate Power,
= Open Panel,
= Disconnect All I/O,

= Switch on power to Q5 only,
= Wait for controller to settle.

= Unplug all Ethernet cables. Any RS-485 networks may be left connected,

Perform the Reset

@

Press and hold down the service button # (located behind
the drop down flap) until the ring indicator flashes yellow, then
release the button. To initiate the reset press the button again

The reset process may take up to several minutes
depending on the controller type. Do not remove power
to the controller until the process has completed.

while the indicator is still flashing.

While the controller is erasing the strategy, the ring indicator
will remain yellow and appear to ‘rotate’. When the reset is
complete the controller will reboot as shown in step 9 on page
4.

The strategy, user modules (passwords, etc), alarm logs, and
plots records are cleared down, and all other parameters will
be returned to their default settings as shown in step 15 on
page 8.

Note: Time and date are left at their current values, and the
license is not affected by the reset.

4 N\
=10's 5s 60s 10s

O 0-0°0-Oma

! Release

Long Press Short Press
>0 “LO
7 7 7 7
4 ye % % v %

Re-configure the Controller

®

Go to step 15

|
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4 RESET A T1L DEVICE TO FACTORY DEFAULTS

A factory reset will erase all settings and reboot the device into its default configuration.

@ Isolate Power and Disconnect all /O from the Device
Follow steps 1, 2, 4, 8 and 9 (on pages 1 to 4) to:

= Isolate any power supplies used by the device inputs or outputs,
= Open panel,

= Disconnect all I/O from the device,

= Isolate the device power supply.

@ Perform the Reset

With the device powered up, use the service button to initiate The reset process will only take a few seconds depending
the reset process as follows: on the module type. Do not remove power to the module
until the process has completed.

e 4.

When the reset is complete the module will reboot and the
controller will attempt to re-address the module as shown in

Yy
Ve )
=10s i <56s | <5s
P o '@ Qe ‘o
" "*/. e Module will
ik : : : then reboot into
| . . i default state
Long Press Release EShort Press
O 10-15s O : <1s O
r <
’ 7 ’ ’ 7
\_ J

@ Reconnect Inputs & Outputs and Check Operation

Follow the guidance from step 30 on page 16, through to step ‘43’ on page 22.

|
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5 MANUAL CHANNEL CONFIGURATION
51 Set Channel Type and Value

When 1Q5-10 HOA modules are in offline mode the channels must be configured to match the connected I/0 and the required value
set.

@ Select Channel

@ Select Channel Configuration

A NIA!
A K A
DO H

AO 0-11V = VOLTAGE
AO 0-20mA L, Ot
v

Note: If N/A is selected the channel can’t be used.

VOLTAGE
0-11vV

0%

@ Set Output Value
VOLTAGE

VOLTAGE 0-11V
0-11vV N .
N . 0,
0% .25%.
Output in Mnual Output in Manual

VOLTAGE
0-11V

SET 25%

-]
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5.2 Reset Channel Type

Select Channel

25% 1
| oo 5] oo 6 loo 7]0o ]

ON ON

VOLTAGE
0-11V

SET 25%

Reset Channel

VOLTAGE
0-11V

SET 25%

6 SET AN 1Q5-10 MODULE TO ONLINE MODE

Set an 1Q5-10 Module Back to Online Mode

retain their overridden status.

to listen for the controller.

required.

When in offine mode the IO module will
communicate with the controller after 3 minutes of inactivity.
If it is able to communicate with the controller it will exit offline
mode and wait for the configuration from the controller. Any
channels that have been overridden while in offline mode will

If it is unable to communicate with the controller it will continue

If required it can be forced to exit off-line mode during the 3
minute wait by pressing the Auto button for 3s.

Note: Resetting the 10 module will start the module set up
process enabling online or offline mode to be selected as
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Please send any comments about this or any other Trend technical
publication to techpubs@trendcontrols.com
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